L21 - Introductory Lab for Distributed HMI with FactoryTalk® View Site Edition

For Classroom Use Only!
Important User Information

This documentation, whether, illustrative, printed, “online” or electronic (hereinafter “Documentation”) is intended for use only as a learning aid when using Rockwell Automation approved demonstration hardware, software and firmware. The Documentation should only be used as a learning tool by qualified professionals.

The variety of uses for the hardware, software and firmware (hereinafter “Products”) described in this Documentation, mandates that those responsible for the application and use of those Products must satisfy themselves that all necessary steps have been taken to ensure that each application and actual use meets all performance and safety requirements, including any applicable laws, regulations, codes and standards in addition to any applicable technical documents.

In no event will Rockwell Automation, Inc., or any of its affiliate or subsidiary companies (hereinafter “Rockwell Automation”) be responsible or liable for any indirect or consequential damages resulting from the use or application of the Products described in this Documentation. Rockwell Automation does not assume responsibility or liability for damages of any kind based on the alleged use of, or reliance on, this Documentation.

No patent liability is assumed by Rockwell Automation with respect to use of information, circuits, equipment, or software described in the Documentation.

Except as specifically agreed in writing as part of a maintenance or support contract, equipment users are responsible for:

- properly using, calibrating, operating, monitoring and maintaining all Products consistent with all Rockwell Automation or third-party provided instructions, warnings, recommendations and documentation;
- ensuring that only properly trained personnel use, operate and maintain the Products at all times;
- staying informed of all Product updates and alerts and implementing all updates and fixes; and
- all other factors affecting the Products that are outside of the direct control of Rockwell Automation.

Reproduction of the contents of the Documentation, in whole or in part, without written permission of Rockwell Automation is prohibited.

Throughout this manual we use the following notes to make you aware of safety considerations:

**WARNING**

Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**IMPORTANT**

Identifies information that is critical for successful application and understanding of the product.

**ATTENTION**

Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you:

- identify a hazard
- avoid a hazard
- recognize the consequence

**SHOCK HAZARD**

Labels may be located on or inside the drive to alert people that dangerous voltage may be present.

**BURN HAZARD**

Labels may be located on or inside the drive to alert people that surfaces may be dangerous temperatures.
# Introductory Lab for Distributed HMI with FactoryTalk® View Site Edition

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before you begin</td>
<td>5</td>
</tr>
<tr>
<td>About this lab</td>
<td>5</td>
</tr>
<tr>
<td>Who should complete this lab</td>
<td>5</td>
</tr>
<tr>
<td>What you will accomplish in this lab</td>
<td>5</td>
</tr>
<tr>
<td>Tools &amp; prerequisites</td>
<td>5</td>
</tr>
<tr>
<td>Exercise 1: Explore FactoryTalk View Runtime – MightyQ’s Cookie Factory (10 min)</td>
<td>7</td>
</tr>
<tr>
<td>Objectives</td>
<td>7</td>
</tr>
<tr>
<td>Why it's Important</td>
<td>7</td>
</tr>
<tr>
<td>Lab Procedure</td>
<td>7</td>
</tr>
<tr>
<td>Exercise 2: Create an Application (10 min)</td>
<td>15</td>
</tr>
<tr>
<td>Objectives</td>
<td>15</td>
</tr>
<tr>
<td>Why it's Important</td>
<td>15</td>
</tr>
<tr>
<td>Lab Procedure</td>
<td>15</td>
</tr>
<tr>
<td>Exercise 3: Create HMI displays, Import HMI displays (20 min)</td>
<td>22</td>
</tr>
<tr>
<td>Objectives</td>
<td>22</td>
</tr>
<tr>
<td>Why it's Important</td>
<td>22</td>
</tr>
<tr>
<td>Lab Procedure</td>
<td>22</td>
</tr>
<tr>
<td>Exercise 4: Create display objects</td>
<td>38</td>
</tr>
<tr>
<td>Objectives</td>
<td>38</td>
</tr>
<tr>
<td>Why it's Important</td>
<td>38</td>
</tr>
<tr>
<td>Lab Procedure</td>
<td>38</td>
</tr>
<tr>
<td>Exercise 5: Animate display objects (10 min)</td>
<td>63</td>
</tr>
<tr>
<td>Objectives</td>
<td>63</td>
</tr>
<tr>
<td>Why it's Important</td>
<td>63</td>
</tr>
<tr>
<td>Lab Procedure</td>
<td>63</td>
</tr>
</tbody>
</table>
Exercise 6: Create Trends (10 min) ............................................................................................................ 69
Objectives .................................................................................................................................................. 69
Why it's Important ...................................................................................................................................... 69
Lab Procedure ............................................................................................................................................ 69

Exercise 7: Create a FactoryTalk View SE Client (10 min) ......................................................................... 79
Objectives .................................................................................................................................................. 79
Why it's Important ...................................................................................................................................... 79
Lab Procedure ............................................................................................................................................ 79

Exercise 8: Configure Alarms (10 min) ...................................................................................................... 86
Objectives .................................................................................................................................................. 86
Why it's Important ...................................................................................................................................... 86
Lab Procedure ............................................................................................................................................ 86

Exercise 9: Using FactoryTalk ViewPoint with FactoryTalk View SE (15 min) ........................................... 99
Objectives .................................................................................................................................................. 99
Why it's Important ...................................................................................................................................... 99
Lab Procedure ............................................................................................................................................ 99
Before you begin

About this lab
This hands-on lab provides you with an opportunity to explore introductory features of FactoryTalk View Site Edition (FactoryTalk View SE). If you are new to FactoryTalk View Site Edition and FactoryTalk ViewPoint, this hands-on lab allows you to learn about the basic capabilities and features of a FactoryTalk View SE application for both desktop and mobile. You will build a simple application from the beginning. Topics include creating an application, adding displays, working with tags and animations, basic alarming, trending, and mobility. This lab will give you a solid understanding of how a FactoryTalk View SE HMI application works, and how you can extend it mobile devices.

This lab takes approximately 90 minutes to complete.

Who should complete this lab
This hands-on lab is intended for all audiences. Basic computer operation is the only prerequisite knowledge needed for the lab.

What you will accomplish in this lab
As you complete the exercises in this hands-on lab, you will gain an understanding of the functionality and capability of FactoryTalk View Site Edition by:

- Exploring the MightyQ Cookies application's runtime and design components
- Creating a new application
- Setting up PLC communication
- Creating and importing HMI displays
- Creating display objects
- Animating display objects based on PLC values
- Creating trends
- Creating and configuring PLC based HMI alarms
- Creating and viewing a client HMI session
- Exploring the same application in FactoryTalk ViewPoint

Tools & prerequisites
There are no prerequisites for this hands-on lab.

Hardware
This hands-on lab does not require any hardware beyond the lab computer. A Logix5000 controller could be used in place of Studio 5000 Logix Emulate.
Software
This hands-on lab uses the following software:
- FactoryTalk View Site Edition 9.00.00 (CPR 9 SR 9)
- FactoryTalk ViewPoint SE 9.00.00 (CPR 9 SR 9)
- RSLinx Enterprise 5.90.00 (CPR 9 SR 9)
- RSLinx Classic 3.80.00 (CPR 9 SR 8)
- Studio 5000 Logix Designer v24.01.00
- Studio 5000 Logix Emulate v28.02.00

Lab Files
This hands-on lab uses the following files located in the listed folders:
- In the Class Files folder (C:\Lab Files\FTView SE Intro Lab)
  - Images (folder) – images to be used as display backgrounds and company logos
  - FullCookieDemo.cli – a View SE client configuration used for launching the finished Cookie demo application
  - Cooling.gfx – a FactoryTalk View SE display to be imported into the lab created application
Exercise 1: Explore FactoryTalk View Runtime – MightyQ’s Cookie Factory (10 min)

Objectives
In this exercise, you will complete the following tasks:

- Launch the FactoryTalk View SE Client
- Navigate between existing HMI displays
- View the FactoryTalk Alarm and Events alarm viewer

Why it’s Important
As a potential application developer, it is important to understand how the end user will interact with the developed application. Operators, engineers, administrators and maintenance staff may all use the same application to interact with a working system. Interface design is important for operational efficiency and effectiveness. Exploring the sample application will also give the lab participant a better understanding of what the end goal of the overall hands on lab session.

Lab Procedure
This lab exercise makes use of a previously configured FactoryTalk View SE application. The application is a simulation of an entire cookie production site. Production from batching to packaging is included in the sample application. The application is referred to as ‘MightyQ Cookies’ or just ‘Cookies’.

1. Navigate to the class files in Windows Explorer. The class files folder is located at:
   
   C:\Lab Files\FTView SE Intro Lab.

   OR – alternatively you can go to the Start Screen to launch the shortcut to this file folder:
2. Double click on the FactoryTalk View SE Client launcher, named **FullCookieDemo.cl**.
This will cause a small pop up display with a double progress bar to appear. This progress bar will take a few seconds to finish.

With the FactoryTalk View SE Client opened, you should be able to see the following screen.

NOTE: If you would like to adjust the Client application window position on your monitor, click on the title bar and drag the client window to the desired position. In most use cases the client window will have a startup setting to maximize the client window to fill the entire monitor. For the purposes of this demo we have chosen a smaller client window size.
The MightyQ Cookie HMI demo is comprised of two main screen areas. The first area is the top banner. This screen area is always on display, and is for general system wide information and navigation. Typically, the banner area is used for alarm information, time display, navigation, and application identification. The far left icon, in the shape of three horizontal bars, will call a drop down list. This drop down list contains a historical navigation menu.

The final bottom screen area is the production display. This area of the HMI changes based on how the user navigates between displays. Clicking on a production section name (e.g. Cooling or Case Packer) on the navigation banner will show a display with information specific to that area of production, replacing the previous production display. The display shown below is for plant wide overview.
3. Move the mouse cursor over the top of the four Silo level indicators in the top right portion of the screen.

Notice the appearance of a black border around the entire Silo level indicator group.

**Tip** – Objects that have a click action will be indicated with a bold border that appears when the mouse cursor is moved over that object. The action that occurs when an object is clicked depends on the **Touch Animation** set for that display object. We’ll learn more about Animations in a later exercise.

4. Click on the **Silo Group** indicators. The resulting material storage display is shown.
5. Click on the **Mixer** text in the Navigation banner. The resulting mixer display is shown.

6. Click on the **Mixer mode select switch**. The selector switch will change from AUTO to SEMI-AUTO (or vice versa).
7. Click on the **Alarm** text in the navigation banner. The alarm display will be shown.

From here, you can see the alarm summary display object in the bottom area of the display. Alarm functionality will be discussed in greater detail in a later exercise.
8. Close the display client by clicking on the X icon in the top right corner of the window.

This concludes Exercise 1 [Explore FactoryTalk View Runtime – MightyQ's Cookie Factory].
Exercise 2: Create an Application (10 min)

Objectives
In this exercise, you will complete the following tasks:

- Create a new FactoryTalk View SE Local Station application
- Create an RSLinx Enterprise data server
- Create a device shortcut to a programmable controller

Why it’s Important
The FactoryTalk Application is a container for all of the necessary functions of a full HMI control environment. Creating the application is the first step to building an HMI project.

A FactoryTalk application typically contains the following resources:

- Area containers (useful for larger, site-wide applications)
- HMI project(s)
- Data provider(s)
- Alarm server(s)

Data Servers provide the application with process information. Typically, data servers are connections to PLCs and PACs, but third party (OPC) data providers can connect to a multitude of data sources.

Lab Procedure
In this exercise, you will use the FactoryTalk View SE Studio HMI development environment.
1. Launch the FactoryTalk View Studio program. This can be done from the start menu or from the task bar shortcut.
2. When prompted to select an application type, choose:
   (A) View Site Edition (Local Station)
   (B) Click Continue

3. When the 'New / Open Site Edition (Local Station) Application' pop up is shown, select:
   (A) New tab in the top left corner.
   (B) In the resulting New Application tab, Application Name field type "CookieDemo".
   (C) Click the Create button at the bottom left of the pop up.
4. An ‘Add Controller Instruction Faceplates’ pop up will be displayed.
(A) Click the Clear All button.
(B) Click the OK button. For this introduction application, we will not use any Controller Instruction Faceplates.

5. At this point, you should be able to observe the FactoryTalk View Studio main window. The window contains an Explorer pane (seen on the left) and the editor pane. The content of the editor pane depends on what is selected from the ‘Explorer’ pane.
Looking closer at the Explorer pane, you can see the Application and the HMI project that have been created.

Tip – Local Station applications (versus Network applications) can only have HMI and DATA servers on the same computer. The HMI server is named the same as our application name, and automatically created. In a Network application, the HMI project must be created manually, and may be named differently than the application.

6. (A) Right click on the Application CookieDemo.  
(B) In the displayed menu select Add New Server.  
(C) In the next displayed menu, choose Rockwell Automation Device Server (RSLinx Enterprise).
7. In the ‘RSLinx Enterprise Server Properties’ window:
   - Click on the Alarm and Events tab.
   - Check the Enable alarm and event support checkbox.
   - Uncheck the Enable History checkbox.
   - Click the OK button.

8. In the Explorer pane, expand the newly created RSLinx Enterprise data server object and double click on the Communication Setup option.
9. In the device shortcut editor pane, complete the following tasks:
   (A) Click on the **Add** button.
   (B) Type in the name **"CookieLine"** into the name field.
   (C) In the device tree, browse the **1789-A17, Backplane** object and select the ‘**RACE_CookieLine**’ RSLogix 5000 Emulator processor.
   (D) In the bottom area, **click** on the **Alarm and Events, Enable** selection and pick ‘**Yes**’.
   (E) Click on the **Apply** button. In the resulting pop up, click the **YES** button (the pop-up is not shown).
   (F) To finish creating the device shortcut, click the **OK** button at the bottom right.

   ![Device Shortcut Editor](image.png)

   This concludes Exercise 2 [ Create an Application ].
Exercise 3: Create HMI displays, Import HMI displays (20 min)

Objectives

In this exercise, you will complete the following tasks:
- Create a header display
- Create an overview display
- Add a previously developed cooling line display
- Create an alarm display

Why it's Important

A graphic display represents the operator’s view of plant activity. The display can show system or process data, and provide operators with a way to read values from or write values to external devices such as programmable controllers.

Lab Procedure

Create the Header display

This display will be used for status and navigation information. Unlike the other displays, this display is intended to be always on display, and will be configured to be displayed at the top of the screen.

1. In the Explorer pane of FactoryTalk View Studio, right click on the Displays object in the Graphics folder within the CookieDemo HMI project. Select New to create a new display.

A new ‘Untitled’ display will be opened in the editor pane. This new display will become the header display. In the next steps, the properties of the display will be edited to allow the header to show up at the correct spot in the HMI client.
2. Edit the properties of this display by right clicking on an open area of the display. From the right click menu, select Display Settings.
3. Make the following changes to the display’s settings:

(A) Uncheck the Title Bar appearance. This should also grey out the System Menu and Minimize Button checkboxes.
(B) Press the Specify Size in Pixels radio button. Set the width and height as follows:
   Width: 1280  Height: 150
(C) Press the Specify Position in Pixels radio button. Set the X and Y positions as follows:
   X: 0  Y: 0
(D) Choose a background color by clicking on the white square and selecting a light gray.
(E) Uncheck the box to Track Screen for Navigation.
(F) Click the OK button to finalize your screen changes.

You should see the display resize and change background color. In later exercises, we will add items to this display.
4. Close this display.

Tip – Make sure that you are closing the display editor, and NOT the entire Studio environment. This is the ‘inner’ close icon, not the outer close icon. Refer to the pictures below.

If the display editor was maximized, it may also look like this:

Make sure you close the inner / lower close icon.
5. Click on the **Yes** button when prompted to save the display.

![Save changes to Untitled?](image)

6. In the Save prompt:
   (A) Type the name **Header** in the Component Name text area.
   (B) Click the **OK** button.

![Save](image)

**Opening an existing display**

After one or more displays have been created, the Displays object in the Explorer pane will have a plus “+” icon to the left, indicating that it has contained items. Expand the container and observe the newly created Header display. Displays can be launched by double clicking on the name of the display, or by right clicking on each display name and selecting 'Open'. Other operations related to displays (like delete, rename, etc.) can be executed from the right click menu.

7. **Double click** on the **Header** display to launch the display editor.

![Explorer](image)

8. Now that you see how to open a display for editing, you can now **Close** this Header display.
Create the Overview display

This display will be used for the starting display in the bottom part of the client interface. It contains a picture of the entire production line. The overview display will be configured to be displayed at the lower part of the screen.

9. Right click on the Displays object in the Explorer pane and create a new display. Refer to step 1 of this exercise if necessary.

10. Right click on the open display and choose Display Settings from the menu.

11. Make the following changes to the new display’s settings:
   (A) Uncheck the Title Bar appearance checkbox. This will also grey out the System Menu and Minimize Button checkboxes.
   (B) Check the Size to Main Window at Runtime checkbox.
   (C) Press the Specify Size in Pixels radio button. Set the width and height as follows:
       Width: 1280  Height: 750
   (D) Press the Specify Position in Pixels radio button. Set the X and Y positions as follows:
       X: 0  Y: 0
   (E) Choose a preferred background color by clicking on the white square.
   (F) Check the box to Track Screen for Navigation. Type the name Overview into the Navigation History Screen Name.
   (G) Click the OK button to finalize your screen changes.
12. With the new display still open, right click on the **Images** container in the Explorer pane. Select the **Add Component Into Application...** menu option.

13. (A) Browse to C:\Lab Files\FTView SE Intro Lab\Images.
(B) Select the **background_01_overview_1280x1024.BMP** file.
(C) Click the **Open** button.
14. Return to the newly created display. From the top menu strip, select **Objects > Drawing > Image.**

**Tip** – The top menu of FactoryTalk View Studio is called the ‘Menu bar’; it changes based on the HMI element you have open and in focus in the editor pane. If you don’t see the Objects menu option, make sure you have a display object open and it has the focus for editing.

15. Move your mouse cursor over the open display. The mouse cursor has changed to include the word ‘Image’ in tiny letters to the bottom right of the cursor. Left click and drag a rectangle of any size on the display.
16. When the mouse button is released from the previous step, an Image Browser window appears.
   (A) Select the background_01_overview_1280x1024 image we imported in the previous step.
   (B) Click the OK button.

   ![Image Browser Window](image)

   The image has been put on the display, but it needs to be in the right spot to not have any blank space on the display. The properties of this image can be modified to put the object in an exact spot.

17. **Right click** on the image object in the display editor and select **Properties** from the right click menu.
18. In the Image Properties window:
   (A) Switch to the **Common tab**.
   (B) In the Common Tab, set both the **X and Y position** to 0 (zero).
   (C) Click the **OK** button.

The image should be displayed in the top left corner.
19. **Right click** on the image object and select **Convert to Wallpaper**. This function makes the image part of the ‘background’ of the display. When an object is in the background, all other objects are by default placed on top of this object.

20. Close this display, and save the display as **Overview**.

**Adding a previously created display**

There may be times when displays will be used across multiple applications. In this case, being able to add existing displays allows previously created displays to be easily reused. The Cooling display for this Cookie Factory application will be imported from an external file location. The Cooling display contains information and objects with information relevant to that area of the Cookie Factory. In future exercises additional trends and animations will be added to this display.

21. **Right click** on the **Displays** container within the Explorer pane and select **Add Component Into Application**...
22. In the Add Component Into Project window:
   (A) Navigate to "C:\Lab Files\FTView SE Intro Lab" folder.
   (B) Select the Cooling.gfx file.
   (C) Click the Open button.
23. Open the newly added Cooling display. (You can double click on the name or right click and select open.)

When the display opens, there’s a large blue object with a white X pattern on it. This is a sign of a missing reference to an image. The background for this display will have to be added to the HMI project.
24. Using the same approach as earlier, add the necessary image to the HMI project by right clicking on the Images container in the Explorer pane.

25. In the Add Component Into Project window:
   (A) Navigate to the following path: C:\Lab Files\FTView SE Intro Lab\Images\ 
   (B) Select the `background_05_cooling_1280x1024.BMP` image 
   (C) Click the Open button.
26. **Close** the Cooling display. If prompted to save this display, click **Yes**. **Reopen** the Cooling display and confirm the background image was properly loaded.

27. **Close** the Cooling display.
28. Create a **new display**. This display will be called **Alarms**. Right click on the new screen and set the following properties:

   (A) Uncheck the Title Bar appearance checkbox. This should also grey out the System Menu and Minimize Button checkboxes.
   (B) Check the Size to Main Window at Runtime checkbox.
   (C) Press the Specify Size in Pixels radio button. Set the width and height as follows:
       Width: 1280  
       Height: 750
   (D) Press the Specify Position in Pixels radio button. Set the X and Y positions as follows:
       X: 0  
       Y: 0
   (E) Check the box to Track Screen for Navigation. Type the name **Alarms** into the Navigation History Screen Name.
   (F) Click the OK button to finalize your screen changes.

29. Close this display and name it **Alarms**.

This concludes Exercise 3 [ Create HMI displays, Import HMI displays ].
Exercise 4: Create display objects

Objectives
In this exercise, you will complete the following tasks:

- Add images to the Header display
- Add navigation buttons to the Header display
- Add static text and dynamic string displays to the Cooling display

Why it’s Important
Basic display objects create the visual structure of displays. They indicate what purpose graphic objects serve. Without them, an operator would have no idea what information an indicator is displaying. Text and shape display objects visually organize information.

Lab Procedure

Building the Header display

The header display will have two images and three navigation buttons added to it. When this section of the exercise is done, the Header display should look like the following:
1. Add the Rockwell Automation and MightyQ’s Cookie Co logos to the application:
   - **Right click** on the **Images** container in the Explorer pane and choose **Add Component Into Application...** and select the following files from C:\Lab Files\FTView SE Intro Lab\Images
     - ra-logo-transparent-small.bmp
     - mightyq cookie co 276_91.bmp
   - **Click** the **Open** Button.

2. In Studio open the Header display (if it is not already open). Add the images to the Header display. The last time we added an image, it was done using the Menu Bar at the top of the Studio window. This time, find the Image icon in the toolbox and click on it.
3. With the Image tool selected (you can tell this from your cursor), click and drag a rectangle on the header display.

(A) Select the **Rockwell logo** as the image source.

(B) Click the **OK** button.

4. **Right click** on the resulting Rockwell logo image and select **Properties**. In the properties window, change the Image Back Style to **Transparent**. Click the **OK** button.
5. Repeating steps 2 – 4, add the MightyQ logo in the same way, and move it to the far right side of the display.

6. Using the Button tool (as seen below), create a button on the Header display. Don’t worry about how big the button object is for now; you can modify the size later. You can also use the Menu Bar menu by selecting Objects > Push Buttons > Button.

When you click, drag and release the cursor, the properties window for the button object is displayed.
7. On the button properties window, make the following edits:

**General** tab
(A) Set the Style to No Border
(B) Uncheck the Highlight when object has focus checkbox

**Action** tab
(C) Type in the following for the Release action: **Display Overview**

In the **Up Appearance** tab
(D) Change the Fore Color to White and Back Style to Transparent
(E) Change the Caption to Overview
(F) Change the Font Size to 18
(G) Click the Bold style Font button (alternatively, use the … browse button to set the style)

In the **Common** Tab
(H) Set the Height to 50 and the Width to 200

Click **OK** when you are finished making the changes.
The resulting button looks like the following image. The button is indicated by the 8 selection markers.

![Image of button with selection markers]

8. Make two copies of this button object. This can be done by left clicking on the button object to select it, and then pressing the keyboard shortcut **Ctrl+C** (hold Ctrl and press C), and then pressing the keyboard shortcut **Ctrl+V** to paste a copy of the button on to the display.

For the two buttons, right click on each button and select Properties. In the Properties menu of each button, make the following changes:

   For the Cooling area button:
     - On the action tab, change the Release Action to **Display Cooling** (refer to ‘C’ of the previous step)
     - On the Up Appearance tab, change the Caption Text to **Cooling** (refer to ‘E’ of the previous step)

   For the Alarms button:
     - On the Action tab, change the Release Action to **Display Alarms**
     - On the Up Appearance tab, change the Caption Text to **Alarms**

![Image of button with properties changes]

9. To align all of the buttons, hold the Control key and left click to select each button. You can also left click and drag to ‘rubber band’ the three buttons together. The Header display should have each button selected, as shown below.

![Image of aligned buttons]
10. With the three buttons selected, use the Menu Bar and make the following selections:

- Arrange > Space Horizontal
- Arrange > Align Bottom

Your Header display should look similar to the following image:

Verify that the buttons are aligned with the bottom of the screen by holding down the shift key and dragging them to the bottom with your mouse or setting the Top property on the Common tab of the Properties dialog of each to 100.
11. Use the Menu Bar and select the rectangle tool.

**Objects > Drawing > Rectangle**

Alternatively, you can click on the Rectangle toolbox icon to select the Rectangle tool.

**Tip** – Hovering the mouse cursor over any of the toolbox icons will allow you to see the purpose of that icon in the form of a yellow label. Try it out!
12. With the Rectangle tool, drag a rectangle object on to the display. This rectangle will be used as a background for the navigation buttons. Don’t worry about the exact size; these properties will be changed later. The properties window for the new rectangle object should pop up.
13. In the rectangle properties window, make the following changes: In the **General** tab:

- **(A)** Change the **Line Style** to **None**
- **(B)** Change the **Back Style** to **Gradient**
- **(C)** Click on the **Back Color** to launch the **Gradient Fill window**. In the **Gradient Fill window**:
  - **(D)** Change the **Start Color** to a dark grey
  - **(E)** Change the **End Color** to a lighter grey
  - **(F)** Change the **Shading Direction** to **Vertical**
  - **(G)** Change the **Fill Direction** from **Dark to Light**
(G) Click on the **Common** tab:
- Change the Height to 50
- Change the Width to 1280
- Change the Top to 100
- Change the Left to 0

(H) Click the **OK** button.

With those properties changed, the Header display should look similar to the following image:

The rectangle has been drawn on top of the previously created buttons.

**Tip** - By default, objects have a ‘depth’ order based on when the object was created on the screen; later objects are placed over previously created objects. This depth order can be indirectly changed using the ‘Bring to Front’ and ‘Send to Back’ options on the Arrange context menu / Menu Bar.
14. Right click on the recently created rectangle and select **Arrange > Send to Back** from the right click context menu.

The Rectangle should now be shown underneath the original navigation buttons.

15. **Close and save** the Header display.
Building the Cooling display

The Cooling display has some work already completed, but needs additional functionality added. The functionality for Cooling Zone 1 has been finished, but the second and third cooling zones still have development work left to do. Trends on the Cooling display will be completed in a later exercise. The following elements will be added in this exercise:

- Zone 2 Text label
- Zone 2 status String Display
- Total Units Numeric Display
- (optional) Zone 3 Text label
- (optional) Zone 3 status String Display

16. Open the Cooling display from the Explorer pane.

17. Use either the Menu Bar or the toolbox to select the **Text tool**.
18. Click and drag on the display to create a text object:

(A) Draw the text object over top of the second cooling Zone’s light gray label area. Then make the following changes to the Text object’s Properties window:

(B) Change Text to ZONE 2

(C) Change the Font Size to 12 and set the Font as BOLD.

(D) Change the Fore Color (Font Color) to dark grey and uncheck the Size to Fit checkbox.

(E) On the Common tab change the Size to 31 Height and 108 Width.

(F) Change the Position to 117 Top and 629 Left.

(G) Click OK
Using tags in Display objects

The next object that will be created makes use of a live PLC value. These individual PLC values are referred to as ‘tags’. A tag is essentially a reference to a process value, for example the pressure of a holding tank, the number of parts made in a shift, etc. In FactoryTalk View Studio tags can be referenced by themselves, or used as part of a logical expression for more complex relationships.

19. Use either the Menu bar or the toolbox to select the **String Display tool**.
20. Using the teal area of Zone 2 as a guide:

(A) Draw a String Display object on the display. The properties window for the String Display object will appear. In the Properties window, make the following changes:
(B) On the Common tab, Change to **20 Height** and **108 Width**.
(C) Change the Position to **120 Top** and **766 Left**.
On the General tab:

(C) Change the Expression to

\[ \text{If } \{::[	ext{CookieLine}][\text{Cooling}\_\text{Zone2}\_\text{InZone}] = 1 \text{ then } "Cooling" \text{ else } "Idle" \} \]

*You can either type this in directly, or refer to the next page for how to use the expression editor.*

(D) Change the Dimensions width to 9 (if it is not already)

(E) Change the Justification to Center

(F) Click OK.
To change the Expression field, you can either type in the expression as it is seen above, or you can ‘build’ the expression using the expression editor. If you use the expression editor, do as follows:

Click on the If button and select IF

- Click on the Tags button and in the Tag Browser window, select the following path from the Folders pane (A):
  
  **CookieDemo > CookieLine > Online**

- In the Contents pane, select the (B) *Cooling_Zone2_InZone* tag and confirm the tag name in the (C) Selected Tag text area.
- Click OK and the tag browser will close with the selected tag displayed in the Expression text area.

**Tip** – If you don’t see the correct folder structure in the Folder pane (left side), or don’t see tags in the Tags pane (right side), click the Refresh All Folders button.

There is no example image shown for the next steps while using the Expression Editor:

- Click on the Relational button and select == EQ.
- Type the value 1
- Click the If button and select Then
- Type in “Cooling” (include the double quotes)
- Click the If button and select Else
- Type in “Idle” (including the double quotes)
- Click the Check Syntax button. The area to the right of the Check Syntax button should say ‘Valid’

As stated in the steps above, the resulting expression that you want to see is as follows:

```
If {::[CookieLine]Cooling_Zone2_InZone} == 1 then "Cooling" else "Idle"
```
To set the font properties, right click on the new string display and select **Property Panel**.
In the Property Panel window:

(A) Verify the selected object is *StringDisplay1* (*StringDisplay*)

(B) Change the **Font** to be 12 point bold by clicking the browse … button in the value field

(C) Change the **ForeColor** to dark grey by clicking the browse … button in the value field

**Tip** – The Property Panel window will display the properties of the currently selected object. Try clicking on another object in the display and observe how the Property Panel window changes to display the properties of the newly selected graphic object.

Close the Property Panel window by clicking on the X in the upper right-hand corner.

The two zones should look as follows:
22. Use either the Menu bar or the toolbox to select the **Numeric Display tool**.
23. (A) Using the Numeric Display tool, draw a Numeric Display where the Total Units indicator should be.

The Numeric Display Properties window will appear. In the Properties Window, make the following changes:

On the Common tab:
(B) Change the Height to 20 and the Width to 60
(C) Change the Top to 535 and the Left to 719

On the General tab:
(D) Use the Tag browser (click on the Tags button) and find the Total Parts tag
(E) In the Folder pane: **CookieDemo > Cookie Line > Online > Program:Cooling**

(F) In the Contents pane: Select the `mTotalParts` tag

(G) Click OK

(H) Change the Field Length to 5

(I) Change the Justification to Center

(J) Click the OK button.

**Tip** – If you don’t see the correct folder structure in the Folder pane (left side), or don’t see tags in the Tags pane (right side), **click the Refresh All Folders button.**
24. (A) **Right click** on the Numeric Display object that was just created.
(B) Select **Property Panel** from the right click menu.
(C) On the Property Panel, click on the **ForeColor** item and select **Blue** from the color Picker. Click on the **Font** item and set the Font to **Arial, Bold, size 12**.
Close the Property Panel when done.

The full Cooling display should look like the following image:
25. To test your display, click on the **Test Display** button from the toolbox.

Tag values should populate on the screen, and the existing trends should begin to run. Observe the screen changing. Then click the “**Edit Display**” button that is next to the “Test Display” button to stop testing the display.

26. **Save and close** the Cooling display.

This concludes Exercise 4 [Create display objects].
Exercise 5: Animate display objects (10 min)

Objectives
In this exercise, you will configure the background of a status indicator to change its color based on the state of the related Cooling Zone.

Why it’s Important
Animations of display objects allow for changing some properties of display objects based on PLC tag values. The following properties of objects can be modified through animations:
- Visibility
- Color
- Fill
- Position on screen (Horizontal and Vertical
- Size (Width and Height)
- Rotation
- Touch (apply actions to objects)
- And more!

Lab Procedure
1. Open the Cooling Display from the Explorer pane.
2. **Right click** on an open space of the Cooling Display and select **Object Explorer**.

![Object Explorer](image)

Tip: The Object Explorer allows you to see the grouping and arrangement of objects on a display. Selecting an object in the Object Explorer is effectively the same thing as selecting it directly on the display. The check boxes can be unselected to hide the visibility of objects on the display. This is very useful when interacting with complex Grouped objects that are layered on the display. Objects can be grouped together by using the **Menu bar** **Arrange > Group** option.
3. In the Object Explorer, expand the Zone2Group and expand the Zone2StatusGroup to reveal the Zone2AnimationPolygon. Left click on Zone2AnimationPolygon to select it both in the Object Explorer and the Cooling display, as seen below:

![Object Explorer and Cooling display](image)

**Tip** – The names of objects are created by default as the object type with a number for the number of objects of that type created on that display, for example, StringDisplay3. These names can be changed using the Property Panel (or the Properties window, on the Common tab).

4. Right click on the Zone2AnimationPolygon and select Animation > Color from the menu. The animation window will be displayed.

![Animation window](image)
5. In the Animation **Color** tab, click on the **Tag** button and in the resulting Tag Browser window, select the tag 
::[CookieLine]Cooling_Zone2_InZone. Click the **OK** button. This can be done as shown below:
6. For this tag, you will edit animation states from their default values. In the Animation window, underneath the Expression area is the Animation state area. Selecting a state in the left list will cause the Value and Line / Fill objects to update with the state. Edit the following states to have the correct **Value**, **Line**, **Fill** and **Blink** settings:

- **Step A)**

- **Step B)**

- **Step C)**

- **Step D)**

- **Step E)**

7. Click the **Apply** button on the Animation window, and click the **Close** window.
8. Test the display using the Test Display button. When you are done testing, press the Stop Testing button.

With the display in test mode, you should be able to see the color indicator behind the status text change from the default teal color to a White or Green color depending on the state the Cooling zone is in.

9. Save and close the Cooling display.

This concludes Exercise 5 [Animate display objects].
Exercise 6: Create Trends (10 min)

Objectives
In this exercise, you will complete the following tasks:
- Create trend objects on existing displays
- Configure trend pens based on PLC data values

Why it’s Important
The trend object displays real-time data and historical data. Pens on the run-time chart represent data from the tags and expressions that you add to the trend object. The trend object provides extensive, flexible run-time control. You can add pens, toggle between isolated and non-isolated graphing, specify unique line settings, plot one variable against another in XY plots, and print chart data.

Lab Procedure
The Cooling display has two trends already configured for Zone 1. These trends will be created for the second cooling zone (and if time permits, the third zone).

1. Open the Cooling display if it is not already open from the previous exercise.
2. Use the menu bar to select the Trend object. Objects > Trending > Trend
3. Create a trend object that is the full width and about half the height of the Zone 2 panel area.

Notice the Trend controls consume some of the area of the actual plot size. There are several default Trend controls that cover the usable space for the trend. Using the Trend properties, we can change the way the trend appears.

**Tip** – The FactoryTalk View SE trend object has many properties to configure. Play around with the look and feel of the trend object!

4. In the Trend Properties window, make the following changes:
   
   On the General tab:
   
   (A) Change the Display Chart Title to Temp (°C)
   
   To get the degree symbol, hold down the Alt key, type 248 with the numeric keypad and release the Alt key.
On the **Display** tab

(B) Uncheck the Display value bar checkbox
(C) Change the background color to a light grey
(D) Uncheck the Display Line Legend checkbox
(E) Check the Allow Scrolling checkbox
(F) Uncheck the Display Scrolling Mechanism checkbox
(G) Uncheck the Display pen icons checkbox

![Display tab settings](image)

On the **X-Axis** tab

(H) Change the time span to 6 minutes
(I) Change the Major grid lines to 3, Change the Minor grid lines to 1

![X-Axis tab settings](image)
On the **Y Axis** tab

(J) Change the Min / Max value option to Preset

(K) Change the Major grid lines to 1, Change the Minor grid lines to 1

5. On the trend Properties window, go to the **Pens** tab. On the Pens tab, PLC tags are configured as traces on the trend. This trend will have two pens configured. Click on the Add Pens button to launch the Expression Editor.
6. In the Expression Editor window, click on the **Tags** button to launch the Tag Browser.

7. Select the tag `::{::[CookieLine]Program:Cooling.mCoolUDT[1].TempSetPtZone}` from the Tag Browser and click the OK button.

**Tip** – If you don’t see the correct folder structure in the Folder pane (left side), or don’t see tags in the Tags pane (right side), click the **Refresh All Folders** button.
8. At the Expression Editor, confirm the expression shown below and click the OK button.

![Expression Editor dialog box](image1)

9. For the newly created pen, make the following changes:
   
   - Set the Pen color to Blue
   - Set the Minimum Value to 0
   - Set the Maximum Value to 80

   Use the scrollbar to get to the Min and Max value settings for the pen.

![Trend Properties dialog box](image2)
10. Use the previous steps 5 – 9 to add the second pen with the tag 
\{::[CookieLine]Program:Cooling.mCoolUDT[1].TempZone\}. Set the Pen to use the color Green, with the same Min / Max values (0, 80).
11. Confirm the pen settings for the created Trend. Click OK to finish configuring the Trend.

12. If you want to change the Trend window color, this can be done by accessing the Trend’s Property Panel. Right click on the Trend object and select Property Panel. Within the Property Panel:
   - Change the WindowColor property to the same light grey color used for the chart area background color.
   - Change the WindowStyle property to Opaque.
13. Also using the Trend’s Property Panel adjust the position settings to locate the trend in the correct position:

- Change the “Height” position property to 225
- Change the “Left” position property to 619.
- Change the “Top” position property to 148
- Change the “Width” position property to 270.

14. Confirm your trend looks like the following image:
15. Test the display using the **Test Display** button. When you are done testing, press the **Stop Testing** button.

16. **Save** and **close** the Display.

This concludes Exercise 6: Create Trends.
Exercise 7: Create a FactoryTalk View SE Client (10 min)

Objectives
In this exercise, you will complete the following tasks:
- Create a startup macro to manipulate screen starting positions
- Create a FactoryTalk View SE client launcher

Why it’s Important
As a potential application developer, it is important to understand how the end user will interact with the developed application. Operators, engineers, administrators and maintenance staff may all use the same application to interact with a working system. Interface design is important for operational efficiency and effectiveness.

Lab Procedure
1. In the Explorer pane of FactoryTalk View Studio, right click on the Macros object (within the Logic and Control container) and select New from the context menu.
2. The Macro Editor will pop up. The Macro editor window looks very similar to other text editor applications. In the first open line, type in the following commands, one per line:
   Display Header /DT
   Display Overview

   **Tip** – If you double click in the Macro editor, the Command Wizard pop up will be displayed. This wizard allows users unfamiliar with command functionality of View SE the ability to ‘build’ commands using an interface.

   **Tip** – Macros are essentially a list of commands to execute in sequence. This macro will ensure the correct displays are called when a user launches the client. For those curious, the /DT switch means the display will be docked at the top of the screen. If you double click on an open area of the Macro editor, it will bring up a command selector. Using the command selector, you can see all of the different commands that can be issued in a macro.

3. Close the Macro editor and save the Macro as **ClientStartup**.

4. In the FactoryTalk View Studio Menu bar, select the SE Client Launcher: **Tools > Launch SE Client**
5. In the FactoryTalk View SE Client Wizard, click the **New** button.

6. In the FactoryTalk View Client Configuration Name window, type "**CookieDemoClient**" as the name of the configuration file. Click the **Next** button.
7. In the Application Type window, click the radio button for **Local Station** application. Click the **Next** button.

8. In the Application Name window, select **CookieDemo** from the drop down list, and click the **Next** button.
9. In the Client Components window, select the **ClientStartup** macro that was created earlier from the Startup Macro drop down. Click the **Next** button.

![Client Components Window](image)

10. In the Client Window Properties window:
   
   (A) **Specify Client Window size in Pixels** – “Width” of 1336, “Height” of 968.
   
   (B) Uncheck **Allow client to be resized at runtime**.
   
   (C) Click the **Next** button.

![Client Window Properties](image)
11. On the Auto Logout Window, **uncheck** the box for “Enable auto logout”. Click the **Next** button.

12. On the Completion Options window, click the **Finish** button.
13. The client should begin to launch. After the progress bar finishes, the client application should be displayed as shown.

NOTE: If you would like to adjust the Client application window position on your monitor, click on the title bar and drag the client window to the desired position. In most use cases the client window will have a startup setting to maximize the client window to fill the entire monitor. For the purposes of this demo we have chosen a smaller client window size.

14. In the Client application, you can navigate between the displays that have been created in the HMI project. Navigate between the Overview, Cooling and Alarm display.

15. Close the Client window by clicking on the “X” in the top right-hand corner.

This concludes Exercise 7 [ Create a FactoryTalk View SE Client ].
Exercise 8: Configure Alarms (10 min)

Objectives
In this exercise, you will complete the following tasks:
- Create FactoryTalk Alarm and Event server
- Create a tag based alarm
- Create an alarm banner object on an existing display
- Create an alarm summary object on an existing display
- Acknowledge a currently active alarm from the PLC

Why it’s Important
Alarms provide the operator to identify and react to abnormal operation conditions. Annunciating alarm conditions saves time, maintains safety and increases production run-time. Operators interact with FactoryTalk based alarms in several ways:
- The Alarm Banner object
- The Alarm Summary object
- Alarm based animations of display objects

Lab Procedure
Creating a FactoryTalk Alarm and Event Server
The FTAE (FactoryTalk Alarms and Events) server is a program that runs on the HMI computer, constantly monitoring PLC tags for alarm conditions. Adding an alarm server is a one-time configuration, after which individual alarm conditions can be added to the server while it is in production.

1. In the FactoryTalk View Studio Explorer Pane, right click on the CookieDemo application and select Add New Server > Tag Alarm and Event Server.
2. In the Properties window for the Tag Alarm and Event Server, type in "CookieAlarms" in the Name property.

3. On the Priorities and History tab, verify the Enable history box is unchecked and click the OK button.
4. In the Explorer Pane, click to expand the newly created **CookieAlarms** alarm server. **Double click** on the **Alarm and Event Setup**. A small progress bar window will display, and after a few seconds an Alarm and Event Set Up window will be displayed.

   ![Alarm and Event Setup](image)

   **Configuring alarms**

   The Alarm and Event Setup editor is the primary tool for creating and modifying alarms. Depending on the alarm type, different properties will be available in the editor. There are three primary alarm types: digital (on / off) alarms, deviation alarms, and level alarms. For this lab, we will stick with a digital alarm and a level alarm. There are also two types of alarm sources: HMI / tag based alarms, and device based alarms. Device based alarms are built in the ControlLogix controller, using specific ALMA and ALMD instructions. Tag based alarms can originate from any PLC tag value.

5. In the Tag Alarm and Event Set Up window, click on the **New Alarm** button in the top left corner, and select **Digital** from the drop down menu.
6. In the Digital Alarm Properties Window, set the Name to "Cooling Zone Drive Alarm". Set the Message to "Cooling Conveyor Drive has faulted. Check HIM mounted at cabinet SC-107." Set the Severity to 500.

8. In the Input Tag field, the name of the tag selected should appear. Because we need to reference a single bit from the tag, add `.1` to the end of the tag name. It should look like the following:
9. Click on the **OK** button at the bottom of the Digital Alarm Properties window.

10. Click the **Save** button on the Alarm and Event Setup Window. Close the window. If prompted, save your changes.

**Alarm Display Objects**

Alarms can be monitored using two main display objects: the Alarm Summary object, and the Alarm Banner. These objects provide a viewer that can show alarms sorted by severity, time of alarm, etc. They are powerful tools for managing alarm conditions.

11. Open the Header display using the Explorer pane.

12. Use the Menu bar to select the **Alarm Banner** tool.
13. Create an Alarm Banner object in the display area between the two image objects (the logos). The Alarm and Event Banner Properties will be displayed. Click the **OK** button on this window.

14. The Alarm Banner should be shown on the Header display:

15. **Save and close** the Header display.
16. Use the Explorer pane to open the **Alarms** display.

17. Use the Menu Bar to select the **Alarm Summary** tool.

![Image of Explorer pane and FactoryTalk interface]

18. Create an Alarm Summary object that covers the full Alarms display. The Alarm and Event Summary Properties window will be shown. Click on the **OK** button at the bottom of the window to accept the default configuration.

![Image of Alarm and Event Summary Properties window]

19. **Save and close** the Alarms display.
20. Launch the FactoryTalk View SE Client. This can be done from View Studio using the **Tools > Launch SE Client** option from the Menu bar. Select the **CookieDemoClient** configuration and click the **Run** button.

After some time, the client window will be displayed.

You may see some alarms in the banner! These alarms are Device based alarms configured directly in the PLC. The Alarm server listens to these alarms because the PLC was configured in the Data Server configuration from Exercise 2.

When the client application is running (or when a display is in Test mode) the Alarm Banner should have a GREEN icon in the bottom left corner of the banner. This indicates a healthy connection to the Alarm Server. In advanced FactoryTalk configurations, the HMI may not be on the same computer as the Alarm server.
21. Navigate to the Alarms display in the View SE Client.

![Image of Alarms display]

Note: If there are no alarm events in the system, you will see the text *Waiting for Alarm Events…* in the alarm summary and banner. There is simulation logic running in the controller program that automatically generates alarms for purpose of demonstrating alarm functionality but there may be times where no alarms are active and you may get that message during this lab.

22. Switch back to View Studio by selecting the icon from the task bar.
23. Bring up the Command Line window by double clicking on Command Line under the System folder.

![Image of Command Line window]

Tip: The Command Line window can be used to immediately execute commands or macros. You can double click inside the window to bring up the Command Wizard editor or directly type into it. After creating the command and hitting enter, the command will be immediately executed. Note that certain commands are not applicable to running inside of View Studio such as the Display command. When attempting to issue such a command that is not supported in View Studio, you will receive a diagnostic message to the effect of: “The command ‘Display’ is ignored when issued from the development environment or an HMI Server.”

24. Either use the Command Wizard editor or directly type the following command:

```
Set ::[CookieLine]Program:Cooling.Alarm_Control[4].1 1
```

Hit the enter key when completed and the text will disappear.

25. Switch back to the Display Client by selecting the icon from the task bar.
26. After 30-60 seconds, the alarm will be automatically rectified. Notice how it will eventually disappear from the Alarm Banner. This happens because even though the alarm condition has been rectified, it still needs to be acknowledged by an operator or supervisor. Navigate to the Alarms display. If the alarm does not clear within 60 seconds, you can manually clear the alarm by switching back to View Studio and issuing the command:

```
Set ::[CookieLine]Program:Cooling.Alarm_Control[4].1 0
```

You can also use the up arrow in the command window to select the prior command to save some typing.

27. The alarm condition has been rectified, but note that the alarm still shows up in the Alarm Summary.
28. Select the alarm in the Alarm Summary object, and click on the **Acknowledge** button (the leftmost check icon).

29. With the alarm condition rectified and the alarm acknowledged, the Cooling Conveyor Drive alarm disappears from the Alarm Summary object. If historical logging was enabled, the alarm history viewer could be used to review alarms over a period of time.

30. Leave the HMI Client window open.

This concludes Exercise 8 [Configure Alarms].
Exercise 9: Using FactoryTalk ViewPoint with FactoryTalk View SE (15 min)

Objectives
In this exercise, you will complete the following tasks:
- Configure the FactoryTalk ViewPoint portal from a web browser
- Navigate a FactoryTalk ViewPoint application

Why it’s Important
FactoryTalk ViewPoint provides a web based portal for access to a FactoryTalk View application. This can be useful for remote monitoring of production systems, or for users that don’t necessarily need access to all functions of the View SE client.

Lab Procedure
1. Use the Start Screen to Launch the FactoryTalk ViewPoint Administration Portal. The first time this loads, it may take a minute.
While waiting, here's some important information about ViewPoint:

FactoryTalk ViewPoint is an add-on to FactoryTalk View that extends visualization and real-time decision capabilities to browser-based remote users, including plant managers, supervisors or mobile workers. With FactoryTalk ViewPoint, critical information of plant floor operations can now be easily accessed and monitored from virtually any location and virtually any device.

FactoryTalk ViewPoint leverages HTML5 technology which opens up connectivity across common types of mobile devices and modern browsers. Whether you’re using Internet Explorer on an operator workstation, Safari on an iPad or Google Chrome on a Samsung Galaxy Tab®, a web browser is all that is needed to gain access to a web-enabled application.

A FactoryTalk ViewPoint web application consists of graphic displays selected from an existing FactoryTalk View application, converted for viewing in a web browser, and then published to a FactoryTalk ViewPoint Server (also called the web server).

- For Site Edition applications, the FactoryTalk ViewPoint Server runs on a desktop or server computer.
- For Machine Edition applications, a PanelView™ Plus, PanelView™ Plus 6 or PanelView™ Plus 7 Standard operator terminal functions as the server.

You will eventually see a Web Browser open with the ViewPoint Administration Portal.
2. Click on the Publish Displays to Web button.

3. In the resulting webpage, select Site Edition (Local) from the Application type drop down, and select CookieDemo from the Application drop down. Finally, click the Select Graphic Displays button.
Available FactoryTalk ViewPoint publishing options:

**Web Enable**
Select whether each display should be published for viewing in a browser.
- Checked - the display will be published.
- Cleared - the display will not be published.

**Initial Display**
Select which display will be shown when a user first connects to FactoryTalk ViewPoint.

**Mobile Enable**
Select for users looking at ViewPoint from mobile devices. A URL interface is also provided for easier navigation between displays on devices that have smaller screens. You may wish to create displays specifically tailored to mobile users. Mobile URL: http://localhost/FTVP/m/
- Checked - the display will be published to the mobile URL.
- Cleared - the display will not be published to the mobile URL.

**Re-publish all selected displays** (optional)
Overwrite the existing published displays even if their content has not changed.

**Select a Startup Macro** (optional)
If the FactoryTalk View application selected includes a macro, from the Select a startup macro list, select a macro that runs when a client connects to the published application.

4. On the Select Displays webpage, click the radio button to set the Header as the initial display and uncheck it for Mobile Enable. Select the ClientStartup from the startup macro dropdown list, and then click the Publish Displays button.
5. On the Publish display webpage, the progress bar will eventually complete, and the status of each display should be shown as Done. Click on the **Open Web application** button. The web browser will spawn a second browser tab, and the FactoryTalk View application will launch in this second window.

Tip: The FactoryTalk ViewPoint Administration console allows you to publish displays to the web, configure security, set up activations, view server settings and access the on-line help.
6. This view is the ‘Desktop View’ of ViewPoint in the browser. The **Header** and **Overview** displays are initially shown. Prior to publishing this was the selected initial display used in combination with the startup macro.
7. Click on “Alarms” in the header to navigate to the Alarms display. If all the alarms were acknowledged and turned off in previous the lab steps, then no alarms will be shown.

8. Toggle the same alarm from Exercise 8 Step 24 by executing the command shown below using the View Studio Command Window. Observe the new alarm appear in the Alarm Summary.

   Set ::[CookieLine]Program:Cooling.Alarm_Control[4].1 1

Tip: When using the command window, press the up arrow key to show and use any prior used commands.
9. A list of alarms can be filtered by typing in the “Quick filter” window as shown.

10. Click on one of the alarms listed to open a new window that will contain more details about the alarm. Also provided on this detailed alarm window is the ability to “Acknowledge” or “Shelve” the alarm.
11. Navigate to the Cooling display by clicking on “Cooling” on the header and observe the trends.

![Cooling display](image)

12. Writes from displays can be enabled and controlled by security settings. In the browser click on the tab for the FactoryTalk ViewPoint Administration.

![FactoryTalk ViewPoint Administration](image)

Tip: By default, the screens available on ViewPoint are ‘read only’. When a client is set to read-only, the numeric inputs and action buttons that could change PLC values are prohibited. The functionality of some types of objects are not currently supported by ViewPoint in a browser. Compatibility information can be found on Rockwell Automation’s Knowledgebase.
13. Using the FactoryTalk ViewPoint Administration tab that is still open in the browser:
   (A) Click on “Security Settings”.
   (B) Click on “Secured Displays”.
   (C) Click on “CookieDemo” to select the Cooling display.
   (D) Click the box next to “Enable Write” to place a check mark in it.
   (E) Click on “Save” to save the settings.
14. In FactoryTalk View a Mobile Device interface is also offered for easier navigation on devices which may have smaller and varied screen sizes.

(A) Navigate to the following URL in the Chrome browser: http://localhost/FTVP/m/
(B) Notice that the “Header” display is not shown. This because you were instructed back at step 4 to un-check this display so that it was not to be Mobile Enabled.
(C) Near the top click on Alarms that is shown next to Displays (do not click on the display named Alarms).

15. You will see any active alarms here.

(A) Click on the one of the alarms to view the alarm details.
16. Review the alarm details. Notice at the bottom that you are provided with options to **Acknowledge** or **Shelve** the alarm.
17. (A) Near the top of the browser window, click on Displays.
(B) Then click on the Overview display.

18. If you are targeting mobile platforms with FactoryTalk View, you can use one of Chrome’s built in features to set the browser window’s size to a mobile device’s known resolution. To view different layouts, you must enable the developer tools. Navigate from the Menu to More tools and select Developer tools.
19. Use the Toggle device toolbar button to enable the device toolbar above the web page image if not already visible.

20. Select the device to emulate from the drop down list. Note that you can enable other pre-built custom devices through developer tools options by selecting Edit… or set a specific, custom resolution by directly changing the values.
21. The browser content has to be more compact when using smaller display sizes / devices. Notice in the right top corner you can see an indication of the alarms there. Click on the navigation icon on the top right as shown.
22. Click on Alarms.
23. You can click on individual alarms here for more detail and can choose to Acknowledge or Shelve alarms at the bottom.

You may try out other mobile display sizes and/or look at other different displays.

Click the navigation icon located in the top right or left for options.

**Tip** – If you know you will have users looking at ViewPoint from mobile devices, you can create screens specifically for those users, or change the default resize behavior of displays.

This concludes all of the exercises for the lab. Thank you for your time and participation!